
Blu Disc Quick Start Guide 

in 10 minutes 

 

 
based on the video on YouTube 

(https://www.youtube.com/watch?v=0I_H6cuox0s)  

 

 

by 

Theo de Klerk 

 

  

https://www.youtube.com/watch?v=0I_H6cuox0s


2 Blu Disc Studio Quick Start Guide 

Contents 
Tutorial “10 minutes Quick Start Blu Disc Studio” ........................................................................................ 5 

Introduction .............................................................................................................................................. 5 

Two menu types: normal and popup ........................................................................................................ 5 

What does our tutorial bluray disc do? .................................................................................................... 6 

Action diagram for the project ................................................................................................................. 6 

What must be there to compile a bluray disc? ......................................................................................... 7 

Movie files ............................................................................................................................................. 8 

Menu files ............................................................................................................................................. 8 

Starting the project ................................................................................................................................. 11 

Location ............................................................................................................................................... 11 

Video and audio .................................................................................................................................. 12 

Menus ................................................................................................................................................. 13 

Basic project in Project Tree ................................................................................................................... 15 

Menu storage ...................................................................................................................................... 16 

Menu impression ................................................................................................................................ 16 

Menu objects ...................................................................................................................................... 17 

Duplicating menus .................................................................................................................................. 18 

Splitting one menu-of-all into several menus-of-parts ....................................................................... 18 

Retain only main menu buttons on “menu” ....................................................................................... 20 

Retain only popup menu buttons in “Popup” menu .......................................................................... 21 

Retaining only audio options in extended “Menu options” menu ..................................................... 21 

Retaining only audio options in extended “Popup options” menu .................................................... 23 

The final menus ....................................................................................................................................... 23 

Setting default buttons on each menu ................................................................................................... 25 

Setting button actions ............................................................................................................................. 27 

“Menu” menu buttons ........................................................................................................................ 27 

Action for the “Play” button: method 1 .............................................................................................. 27 

Action for the “Play” button: method 2 .............................................................................................. 28 

Action for the “Play” button: method 3 .............................................................................................. 28 

Action for “Menu” menu “Audio” button ........................................................................................... 28 

Actions for “Menu option” buttons .................................................................................................... 29 

Actions for “Popup” buttons ............................................................................................................... 31 



Blu Disc Studio Quick Start Guide 3 

Actions for “Popup options” buttons .................................................................................................. 31 

Copy/Paste using the Action Matrix ................................................................................................... 31 

Adding chapters (playmarks) menus ...................................................................................................... 32 

Creating chapters ................................................................................................................................ 32 

Create chapter (scenes) menus .......................................................................................................... 34 

Set scenes in Popup menu .................................................................................................................. 39 

Simulate the project................................................................................................................................ 39 

Building the disc ...................................................................................................................................... 41 

Burning the disc ...................................................................................................................................... 43 

Nero Burning ROM .............................................................................................................................. 43 

ImgBurn ............................................................................................................................................... 44 

 

  



4 Blu Disc Studio Quick Start Guide 

  



Blu Disc Studio Quick Start Guide 5 

Tutorial “10 minutes Quick Start Blu Disc Studio” 

Introduction 
On YouTube (https://www.youtube.com/watch?v=0I_H6cuox0s) you can 

find a tutorial movie that shows through screen-capture the steps to 

take to create a simple bluray project using Blu Disc Studio standard (not 

the Lite edition, though much of the steps are the same). The movie runs 

less than 10 minutes. But unless you know what it happening, it leaves 

you flabbergasted. 

For that particular reason, this guide was made to provide the written 

explanation and some background information to give you a good start 

in using Blu Disc Studio Lite. This free edition is limited in that it does not 

provide animated menus or playlists which are the final part of the 

tutorial movie. It also doesn’t allow you to have more than 32 movies in 

any blu ray disc compilation, each with a maximum of 4 audio tracks and 

subtitle tracks. 

These restrictions are lifted (to the maximum bluray disc specification 

allows) in the commercial “Standard”, “MX” or “MX Pro” edition that 

you may want to buy once you get acquainted with the free Lite edition 

and want a more professional disc authoring. Information about the Blu 

Disc Studio products can be found at http://blu-disc.net/index.html.  

There is a small deviation between the names of folders in the quick 

start movie and the downloadable files for this project. Most likely, 

some changes were made after the quick start movie was completed.  

This tutorial follows the quick start movie but uses the names currently 

used in the sample project. The sample files can be downloaded from 

http://blu-disc.net/examples.html where you select the “Menu without 

video/audio tracks” (9,7 MB) and complement it with the movies 

themselves in “Video and audio tracks for example menu”.  

Two menu types: normal and popup 
At any one time only a single menu is shown on screen. When a button 

on a menu activates another follow-on menu, the earlier menu 

disappears. 

Blu Disc Studio differentiates between two types of menus: 

 menu – ordinary menu, shown on screen when no movie plays.  

 popup menu – menu that “pops up” while playing a selected 

movie. A popup menu typically allows you to modify some 

settings of the movie playback (such as different audio or 

subtitle) or abort the movie playback and show some other 

menu. 

https://www.youtube.com/watch?v=0I_H6cuox0s
http://blu-disc.net/index.html
http://blu-disc.net/examples.html
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Both menus have a movie playing in the background. For the popup 

menu it is clear: it is the selected movie that plays. For the ordinary 

menu it is a special (usually short) movie that belongs to the menu. 

The menu text and buttons are projected on top of it. If the menu is 

partly transparent, the menu movie can be seen behind the menu text 

and buttons.  If the menu is filling the screen and is opaque, the movie is 

not seen but still heard.  

What does our tutorial bluray disc do? 
The sample project is a simple one: 

 It has one main movie, showing how waves break on the coast. 

o the audio with the movie is either the original sound or a 

music track 

o there are no subtitles 

 It has three menus. The main menu that allows one of the two 

other menus to show. Therefore the main menu has 3 buttons: 

o “play” the movie,  

o “audio” selection for original sound or music  

 the “original”/”music” selection is done through 

the second menu (called “menu options”) 

o “scene” selection: chapter displays of the main movie to 

select a particular scene 

 this third menu is generated automatically 

Audio can be selected, still “play” must be entered to start the 

movie. 

 It has three popup-menus that can be displayed while the movie 

plays in order to change settings. It always starts with the 

“popup” menu through which two other popup menus can be 

shown. Therefore the popup menu has 3 buttons: 

o “menu” – interrupt movie and go back to the main 

menu 

o “audio” – change the audio selection to original sound 

or music 

 this change is indicated on the second menu, 

“popup options” 

o “scenes” – move to a selected scene/chapter of the 

movie. This is shown on a third popup menu that is 

generated automatically. 

Action diagram for the project 
If we want to make an action diagram of this simple disc, the following 

picture would give the rough impression of what we are after. 

Remember, that only one menu can be displayed at any time. Any new 

menu replaces the earlier one on screen. If the second menu adds 
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something to the first one, it must replicate the entire first menu but any 

buttons on this menu simply become a picture. Only the buttons meant 

for the second menu are true buttons. This way it looks like the first 

menu is still there but enhanced with new buttons. 

 

The picture shows how on the main “Menu” menu you can select 

between different buttons and when a button is activated (text shows 

up white) either another menu (for audio or scenes – blue arrows) is 

shown or an action (indicated by a green or red arrow) takes place that 

does something to the movie. 

While the movie plays, the popup menu button on the remote control 

will show the “Popup” menu and again a button can be selected on this 

menu. When a button is activated (text coloured white) either another 

menu (back to “menu”, audio or scenes – blue arrows) is shown or an 

action performed (green or red arrows). 

 

What must be there to compile a bluray disc? 
For a disc, we need: 

 the movies for main movie, extras and the menu backgrounds 

o use a demuxer such as tsMuxer to split a movie into its 

video and audio streams 

o possible subtitle streams in .srt or .sup format (not in 

this example) 

 the menus and their buttons 
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o a main menu with 3 buttons “play”, “audio” and 

“scenes” 

o an extended 2nd menu: if “audio” is selected to allow to 

choose between “original” and “music”.  This extended 

menu disappears when “play” or “scenes” is selected. 

o a to be generated “scenes” 3rd menu 

o a popup menu with 3 buttons “menu”, “audio” and 

“scenes” 

o an extended 2nd popup menu: if “audio” is selected to 

allow to choose between “original” and “music”.  This 

extended menu disappears when “play” or “scenes” is 

selected. 

o a to be generated “scenes” 3rd menu 

Movie files 
The video track allows for MPEG-2 (.m2v), H-264 (.264), H-265 (.265) and 

VC-1 (.vc1) type video tracks (those are the ones supported by the bluray 

standard). 

The audio tracks allow for uncompressed LPCM (usually .wav), Dolby 

Digital in 2 track stereo or 5.1 surround (.ac3), Dolby Digital Plus (.ec3), 

DTS (.dts), DTS-HD High Resolution (.dtshd) or DTS-HD MASTER Audio 

(.dtshd). Many DTS formats all are stored as .dts files without distinction 

in file type. 

The subtitle tracks allow for .srt format, .sup,  BDN XML (.xml) or PES 

(.pes). 

The tutorial uses an H-264 movie file with Dolby Digital audio and no 

subtitles. 

Menu files 
Acceptable menu files are either layered PhotoShop files (.psd) or single 

layer .png files, 32-bits (24+8 bits). 

Note: The total size of all menus in the project must be less than 7900 000 

pixels (not kB!). The adagio for any project therefore is “reuse”. Do not make 

4 menus of 1920x1080 pixels (=4 x 2 073 600 = 8 294 400 pixels) as that will 

issue an error during simulation or project creation. If all menus look alike 

apart from a small picture, use 1 full sized black menu (1080x1920) and only 

the small pictures as additional images. Better still: use 1 full sized black 

menu background video with additional smaller menus on top of it. The 

movie takes no pixels. Also, L-shaped menus are better defined as two legs 

(vertical and horizontal) since all menus are stored as rectangles. The L-shape 

menu then has a lot of unneeded pixels in its surrounding rectangle with L 

along two sides of the rectangle. 

The tutorial uses two PhotoShop files for the “menu” and “popup” menu 

that are shown below. Both are the most extended versions of each 
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menu. Parts of them may be invisible at some instances and only shown 

when a particular choice (“Audio”) is made. For that reason, these 

complete menus are duplicated and their duplicates are trimmed by 

removing the unnecessary elements.  

But we start with two menu files in PhotoShop format that contain all 

text and buttons ever to see on any menu. 

The layers within the PhotoShop file must adhere to a specific naming 

convention if buttons are to be recognized as buttons when the file is 

imported. If a layer has any other name, it becomes a picture part of the 

menu, not part of a button state.   

The naming convention for each button layer is btn:<name>:<state> 

 btn  indicates it is a button layer. Must be typed literally 

 <name>  name of the button. Can be anything as long as it has 

no spaces or punctuation marks. E.g.  SndMusic, Play 

 <state>  A single character, one of:  

o “N” for button shown in “normal” state 

o “A” for button shown in “active” state 

o “S” for button shown in “selected” state 

o “C” for button shown in “current” state 

The minimum states that need to be present are N and S.  

The A state shortly shows a button in a different form when the 

“OK” button is pressed on the remote control. Often there is no 

A state layer as the “OK” action is performed immediately when 

the OK button is pressed on the remote control.  

The C state is set automatically when the button is activated: it 

serves as a memory that this button was the last one pressed. 

It is not a required state: if not given a visual clue it will not 

show. In our tutorial it is used to indicate the latest Audio 

setting (Music or Original) and when opening the Audio menu 

the last made choice is highlighted by a checkmark that happens 

to be the “current” state of the button. 

The checkered background of the menu file shown in PhotoShop means 

that this area is transparent and do not count as pixels within the total 

menu pixel number (that must remain less than 7 900 000). 

 Note that both “Menu” and “Popup” menus look similar – the 

main “Menu” has a “play” button whereas the “Popup” menu 

has a return to “menu” button. 

 The size of each button or menu picture as number of pixels is 

always the surrounding rectangle. So even a circular picture is 

still taking up the size of the rectangle in which the circle fits. 

 The button texts differ slightly depending on their state.  
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o For example, the normal state of the “play” button is 

shown as blue text with white outline: 

 
o the selected state of the button will show itself as an 

inverse image with blue outline. 

 
 The blue surrounding boxes are picture elements. 

The complete menu files look like the images below. The checkmarks re 

the “Current” states of the buttons “Music” and “Original” buttons. 

Their “Normal” and “Selected” states are the words themselves (that 

will invert in colour when selected). Upon activation of one of these 

Music/Original buttons automatically the “Current” state is made visible. 

 
menu.psd 
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popup.psd – identical to menu.psd but for the “Menu” button (instead 

of the “Play” button). 

 

Starting the project 
To start a project in Blu Disc Studio (from here on forwards abbreviated 

to BDS), you open the “New Project” wizard by clicking its button ( ) or 

use the File > New Project menu option. To continue working on a 

previous project, use File > Open. 

Location 
The “New Project” wizard opens a window that first asks you a number 

of questions about the project in general: 

 name of the project 

 folder in which BDS must create the project folder (BDS creates 

additional folders here) 

 default language to use for audio and subtitle tracks 
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The example uses the “DEMO_menu” project located at C:\ . This will 

create the project folder C:\DEMO_menu. On the site of BDS you can 

download a zip file with all necessary files for this project so you can re-

do this entire tutorial yourself. By default it provides the completed 

project in folder C:\DEMO_menu. If you want to replay all steps yourself, 

extract the files into a different location. 

Note: the project name is also the name of the project folder created under 

the “project folder” entry. For example, project “XX” in folder “C:\YY” 

results in a project folder C:\YY\XX.  

Video and audio 
Click “Next” for the following window. This asks for the main movie of 

the project and its audio and subtitle tracks. BDS requires any movie to 

be delivered in its separate components. In the BDS Lite version you 

need a freeware product like tsMuxer to demux your all-in-one video 

files into its separate streams. 

Click on the “…” button and navigate to the folder where your movie is 

stored. The example provides it in folder:\movie  (where “folder” is the 

top folder where you extracted the example files). For this tutorial I’ve 

copied the example files into C:\xDEMO_menu to be able to create the 

tutorial’s C:\DEMO_menu project. 
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Use: 

 \movie\movie.264  (H-264 video)  of a cliff with breaking water 

waves. Specify this in the main movie video track. 

 \movie\movie_music  and \movie\movie_original  (.ac3) as two 

audio tracks – one with music only and one with the natural 

sound of breaking waves. Specify this in the second block for 

audio tracks by clicking on “Add” 

 no subtitle files for the demo (otherwise use the third block and 

click “Add”) 

When done, click “Next” to add the menus of the project. 

Note: In the current main movie as well as all subsequent wizard windows, you 

can enter what is already present and known. If some files for movies or 

buttons are not yet there, simply leave those fields blank. You can always add 

information later – the wizard only sets up the basic structure of the project. 

Menus 
Menus consist of a set of .png files that are layered on top of each other 

or a single PhotoShop .psd file with separate layers. Each layer (or .png 

file) is fully transparent except for the menu parts that will show on 

screen. The menu structure was described earlier in section “Menu 

files”. Remember that the total number of pixels of all menus together 

must be less than 7 900 000 pixels! Reuse rather than duplicate identical 

parts and if a black background is needed: make a small silent black 

menu movie – that won’t take any pixels. 

A bluray player can only display one menu at the time. This menu may 

be partly transparent to allow the background movie to be seen. 

When a new menu is displayed, the old one disappears. If the new one 

looks like the old one, it contains all the elements (pictures, text and 
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buttons) of the old menu as a set of pictures. The new menu only has its 

own buttons that are active as buttons. 

If you consider the screen image as built up from a stack of layers, the 

very bottom layer is always a background menu movie. The menu 

buttons are displayed on top of this background menu movie in higher 

layers. 

In this tutorial the menus are stored in two PhotoShop .psd with layers 

 \Source and imported Files\menu.psd 

 \Source and imported Files\popup.psd 

Both menus contain all possible buttons and options. Once imported, we 

will clone them and personalize each menu by removing any button 

(changing their appearance into a picture) not wanted or needed. 

For the main menu: 

 select the “Import from PSD-file” option 

 navigate to the \Source and imported Files\menu.psd file 

 indicate “plain” for the file (and not PS Designer) 

 use as background movie   \movies\menu.264 

 use as background movie sound  \movies\menu.ac3 

 
 

When done, click “Next” to repeat these steps for the second menu, the 

popup menu. This menu will be shown while the movie plays and is 

shown as “popup” over the movie. 

 

A popup menu therefore has no background video as it is the movie 

already playing. Therefore the PhotoShop file contains only layers for 

the buttons.  
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Click “Finish” to complete the entries. 

This will now generate the project. Additional menus and movies and be 

added later. 

Basic project in Project Tree 
Upon completion of the wizard, a skeleton of the project is created and 

is shown in a window called “Project Tree”. When not visible, you can 

display it by selecting menu View > Project Tree (or press F3 button). 

 

You have added one main menu “Menu”, a popup menu “Popup” and a 

movie called “Movie”.  

 Right clicking on “Menus”, “Popup Menus” or “Movies” headers 

allows you to enter additional menus, popup menus or movies. 

This is useful if you make a disc consisting of several episodes of 

a series of movies. 

 The same is achieved by clicking on the icons at the top of the 

Project Tree window ( ). 



16 Blu Disc Studio Quick Start Guide 

(The Lite version does not show an additional entry, “playlists” and an 

additional icon for it – they are not used in this tutorial). 

Menu storage 
All files imported to create menus and buttons are saved as a set of .png 

files with specific names by BDS. Each menu has its own folder (with 

menu name) in the project folder. The creation happens automatically. 

In the picture below you can see the two menus (Menu and Popup) 

imported and the folder created for “Menu” and some of the generated 

button files like btnPlayN.png for the Play button in normal state. 

 

If you make any change to any of these generated files, that change is 

immediately reflected in the BDS menu. 

Menu impression 
To get an impression of what the menus look like open the “Designer” 

window (View > Designer or press F2). Select an item on the Project Tree 

window and the Designer window synchronizes with the selection and 

shows that item the way it will look on-screen. 

Below you can see what the “Menu” menu item looks like. 

 

As you can see it has all button elements as well as surrounding box 

pictures. The top box with “music”/”original” must only be shown when 

“audio” is selected. This extended audio menu has both the Normal and 

Selected states as well as the checkmark Current state.  

The main menu should display only “Play”/”Audio”/”Scenes” buttons. 

Another menu (“Menu Options”) should display the extension box with 

“Music”/”Original” also, but at the same time show the main menu as a 

simply picture. 

The “Popup” menu looks similar – but note that the button “Play” has 

been changed for “Menu”. During editing of the menus care was taken 

that identical words and items overlapped precisely. Like the “Menu” 
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menu the audio options only should show when “Audio” is selected, so 

we need to split this menu into two menus also (“Popup options”). 

 

Menu objects 
A menu consists of a number of objects.  Objects are buttons (and their 

various states) and background images. They are shown in the “Objects” 

window (View > Objects or press F4). Objects shown in the Objects 

window synchronize with the selected item on the Project Tree window. 

If you click on one of the objects, the Designer window highlights the 

object in question. And vice versa: click on the surrounding “play” box 

and Objects tells you this is the “Object 49”. 

As an example, the objects that are part of the “Menu” menu are shown 

below. The blue icons show the “normal” state of the various buttons on 

this menu. The “P” entries are static background pictures such as boxes, 

lines and plain text. 

The “Normal” state of a button is always displayed on screen. The 

“Selected” state image is shown on top of it. That means that if there is a 

transparent area in the selected state button image, the normal state 

image will shine through. 

The “Current” state of a button is automatically activated when the 

button is activated after selection. It serves as a memory of what button 

on the menu was last pressed on the remote control. This way in our 

tutorial, we can see what audio option (Music or Original) was last 

chosen. 
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Note: what button states are shown on the Designer window and have an 

active colour (not greyed out) in the Objects window depends on which 

states you decide to make visible. The “Show normal”, “Show selected” 

and other buttons ( ) determine this. By default only 

“Normal” states (purple or blue dot) are shown. When buttons have 

several states defined and all state pictures overlap, it is useful to select 

only a single state to be shown in the Designer window. Showing all is 

useful if you want to align various states of a button on top of each other. 

Duplicating menus 

Splitting one menu-of-all into several menus-of-parts 
The two menus “Menu” and “Popup” imported have several buttons too 

many. Only when “Audio” is selected we should see an additional part of 

the menu displaying “original” and “music” buttons. In fact, this is a new 

menu activated from the main menu. We call these new menus “Menu 

options” and “Popup options”. Those menus we will now create. When 

the viewer activates these menus through remote control, it looks like 

the old menu is still there but with some additional buttons. It isn’t in 

reality: the newly selected menu just happens to be identical to the 

previous one and has a few bits more to show. 

What we need to achieve is: 

 One main menu named “Menu” has only the main buttons 

“Play” (or “Menu” in the popup case), “Audio” and “Scenes” 
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 A second menu named “Menu options”  has only the Audio 

selection buttons only but retains the rest of the main menu as a 

picture. 

When “Audio” is selected in the “Menu” menu, the menu seems 

to extend, making a box with buttons for “original” and “music” 

options visible and available  

Both imported menus are duplicated first and then pruned for items not 

needed. 

To copy a menu, simply select the menu in the Project Tree window, 

right-click and select “clone tree item” (or press Ctrl/C). This makes an 

exact duplicate of the menu (with all its buttons) but under a different 

name. 

 

Enter the name under which this duplicate entry will be known. Enter 

“Menu options” as menu name. In the end, this menu should only have 

the active buttons for the audio options: original or music. 

 

 

Repeat the same procedure for the popup-menu and call the duplicate 

menu “Popup options”. 
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Retain only main menu buttons on “menu” 
The original “Menu” has everything and so does its clone “Menu 

options”. In the “Menu” we want to remove the extended elements 

(box, “original” and “music” entries).  The buttons on the “Menu” are 

shown below. The parts not shown we need to remove from the clone. 

 

To do this: 

 select “Menu” in the Project Tree. This shows all objects in the 

Object window 

 Select all  Snd*  (sound) button objects  (select and keep Ctrl key 

pressed on each item; alternatively select first one, keep Shift 

pressed and select the last item)) 

 delete these button states (selection right click > delete or press 

the <delete> button) 

 
 Select the remaining box in Designer window. This highlights the 

“Object 57” picture in the Objects window. 

  
 Delete the box item 

The “menu” now looks like the picture below with three buttons “play”, 

“sound” (displayed as “audio”) and “scenes”. 
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Retain only popup menu buttons in “Popup” menu 
This same process is repeated for the “Popup” menu where the entire 

expanded audio box is removed and only the “menu”, ”audio” and 

“scenes” buttons remain.  

You can use the same process as described above or use a different 

approach. Both result in the same situation – use whatever method you 

find most convenient or logical. We will show you the other method of 

deleting menu elements. 

 Open the Designer view window 

 Select the “Popup” menu in the Project Tree window. This 

synchronizes with the Designer view and shows the “Popup” 

menu in Designer View 

 In Designer view, select all items to be removed (click each one 

while keeping Ctrl key pressed). This highlights multiple objects 

in the Objects window (but only the most recent one in 

Designer) 

 Press <delete> key to remove objects 

The resulting “Popup” menu looks like the image below with its three 

buttons. 

 

Retaining only audio options in extended “Menu options” menu 
When in the “Menu” menu the “Audio” is activated, an extended menu 

should be shown above the “Audio” button to allow selection of 

“original” or “music”. In reality, the menu is not extended: it is replaced 

by a new one that looks like the old one (which has all its buttons 

converted to a “picture”) plus the additional parts (box and buttons). 

It is important to understand the difference between the “selected” and 

“activated” state of a button. Moving the cursor on the menu screen 

with the remote control arrow buttons to “Audio” makes this button 

enter the state “selected”. All other buttons are in state “normal”. By 

pressing the “OK” button on the remote control, the “Audio” button also 

becomes “activated” – it executes whatever action is defined for it. If 

instead we move on to another button such as “Scenes” or back to 
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“Play” the “Audio” button changes state from “selected” back to 

“normal” and nothing happens. 

When “Audio” is activated, we want to display the “Menu options” 

menu. This means we switch from the “Menu” menu to “Menu options” 

menu. Because the “Menu options” menu looks exactly like the “Menu”, 

the viewer will think nothing changed except that the box with audio 

options became visible. 

These two audio options should be the only buttons active as long as 

“Menu options” is shown. This means that any button cloned from the 

“Menu” menu and not part of the audio box, must become a picture on 

the “Menu options” menu. The only buttons that should remain are 

shown below.  

 

 

This means that in the “Menu Options” menu we convert the cloned 

buttons for “play”, “audio” and “scenes” into pictures by taking the 

following steps: 

 Select the “Menu options” menu in the Project Tree. This 

synchronizes the Designer window to show that menu 

 Select a button object on the Designer window that needs to be 

changed into a picture 

 Go to the Properties window (View > Properties or press F11) 

that shows the selected button 

 In the “Name” row item change the function “Button” (at far 

right) into “picture” 

 Repeat this for all three buttons of the “Menu” (“Play, “Audio” 

and “Scenes”) that are now pictures in the “Menu options” 

menu. 

 

The entire “Menu options” menu has now become a static image with 

only two buttons left (“original” and “music”). 
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The objects window for the menu reflects this. The “Snd*” objects are 

the two remaining audio option buttons, the rest has been converted to 

“P” pictures. 

 

Retaining only audio options in extended “Popup options” menu 
The same procedure as for “Menu options” is performed on “Popup 

options” items.  

All buttons “Menu”, “Audio” and “Scenes” need to be converted to 

pictures – only the “music” and “original” button remain. 

 

The final menus 
We now have four menus: 

 Menu – main menu shown at start. Has “Play”, “Audio” and 

“Scenes” buttons, audio options box is absent 
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 Menu options – extended main menu shown when “Audio” is 

activated and showing “original” / “music” as buttons. The rest 

of the menu (looking like “Menu”) is a picture. 

 Popup – menu shown while playing the main movie. It has 

“Menu”, “Audio” and “Scenes” buttons 

 Popup options – extended popup menu shown when “Audio” is 

activated and showing “original” / “music” as buttons. The rest 

of the menu (looking like “Popup”) is a picture. 

Note that by cloning menus and removing unnecessary parts, you also 

reduce the total number of pixels of all menus combined. This number 

must remain below 7 900 000.   

For advanced users, the cloned menus contain several identical image state 

copies of the “Audio” and “Scene” buttons as well as surrounding boxes. If 

you’re pressed for pixel space, you can modify the properties of the images 

for each button to point to one copy of it. This allows you to remove all 

other identical copies of the button state image in all other menu folders. 

On Windows Explorer, you can show the number of pixels by right 

clicking on an Explorer right hand part header where usually name, size 

and date of any file is given. The right click allows you to add or remove 

additional informative columns on the files. In our case, we want to add 

the column of “Dimensions” to see the pixel width x height information. 

By dragging the header “Dimensions” you can display the column before 

some others. In the picture below, we showed it at first column after 

the file name. 
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Setting default buttons on each menu 
It is usual to have buttons ordered from top to bottom and left to right. 

When creating a menu this may not always be the case automatically. It 

depends on the order in which .png files or PhotoShop layers are 

imported into the project. 

BDS uses the first button object in the Objects list of a menu, as the 

default button. This is the selected button when the menu opens for the 

first time (after that “default” is the button last activated on the 

previous time the menu was active). 

For the “Menu” the left most visible button is “Play” and should be the 

default button. But it is actually the last one in the object list. We need 

to rectify this and make “Play” the first one.  

 

To do this: 

 select the “Play” button in the Designer window 

 click on the “Object top” icon ( ) (or press Alt / Home) 
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Now “Play” is top of the objects list and therefore the default button for 

the “Menu” menu. You may shift the position of the other buttons too 

using the up/down arrow buttons on the BDSL menu bar. 

In the “Menu options” menu we have a similar problem: here we must 

correct the order for “Music” and “Original” to ensure “Music” as top 

entry is the default when the menu opens: 

 Select “Menu options” in Project Tree 

 Select “Music” button on Designer window. This selects 

“SndMusic” on the Object window 

 Click on “Object Top” icon. This makes “SndMusic” the first 

button on the Object window. 

 

To make sure the other menus follow the same procedure, repeat this 

for them: 

 Select “Popup” menu and set the “Menu” button on top 

 Select “Popup options” menu and set “Music” button on 

Designer window on top (or SndMusic button in Objects) 
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Setting button actions 
Each button should perform an action depending on what key we press 

on the remote control. This can be navigation (moving to a different 

button, changing which button is currently “selected”) or action driven 

(by pressing the “OK” button on the remote control when a button is 

selected). 

“Menu” menu buttons 
The “Menu” buttons “play”, “audio” and “scenes” are assigned actions: 

 if “play” is activated, the “movie” is played starting at chapter 1 

 if “audio” is activated, the “Menu options” menu is displayed 

 if “scenes” is activated, a special scenes menu (will be built later 

– see section “Create chapter (scenes) menus“ on page 34) is 

displayed 

Action for the “Play” button: method 1 
There are several ways to achieve the goal. We will show you how to do 

it for one button (“Play”) – duplicate these steps for all other buttons. 

Take these steps: 

 Select the “Menu” menu in Project Tree 

 From the Designer window select the “Play” button 

 Right-click opens a menu from which you select the “OK” option 

that defines what happens if “Play” is activated 

 
 “OK” should start the movie playing. (For other buttons the 

display of a menu may be appropriate). 

 
 

The result of this choice is displayed in the Properties window for this 

“Play” button. 
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Action for the “Play” button: method 2 
Rather than using the Designer window to assign an action, you can also 

select a button from the Objects window. The Properties window 

synchronizes with the selected object. The “Press ENTER” row allows to 

specify what to do. If you click on the “>” button at the right, the same 

selection menu as with method 1 pops up to define the action. 

 

Action for the “Play” button: method 3 
A third way of assigning an action to a button is to use the “Action 

Matrix” window (View > Action Matrix or press F8). 

 

 Select a menu in Project Tree 

 The Action Matrix synchronizes with the menu and shows all 

buttons of the menu 

 Select the “Play” button row and right-click in the cell for 

“ENTER” column 

 This opens the action menu. Select “Play movie” for “movie” to 

start at “chapter 1” 

Action for “Menu” menu “Audio” button 
The three methods outlined work for all buttons. The “Audio” button 

should open another menu, the “Menu options” menu. This replaces the 
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“Menu” menu but because it looks identical to it, the viewer thinks only 

an additional box is shown with two audio select buttons. 

Taking method 1: 

 select “Menu” menu in Project Tree 

 select “Audio” button on Designer window 

 right click on “Audio” to open dropdown menu 

 select “OK” state 

 select “Jump Menu” > “Menu options”, default button 

The result is shown in the “Audio” button properties: “Press Enter” 

opens Menu “Menu options”. 

 

Actions for “Menu option” buttons 
The new menu has two buttons: “music” and “original”. These must be 

assigned to select from the audio tracks: 

 “Audio (1)” for “music” 

 “Audio (2)” for “original” 

The tracks correspond with the assignment of the audio tracks when the 

project was created. For additional movies, a new movie entry is made 

in the “Movies” section and the specific audio track order is specified 

there. Showing the “movie” properties of our main movie shows the 

order too. 
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When the “Music” button is selected in the Designer window, it can be 

set to select the first audio track by the proper popup menu selections. 

 

The same procedure is followed for the “Original” button (using Audio 

2).  

Next we want to remember the choice made by activating “Music” or 

“Original” by leaving the “Current” state button image visible. This state 

is shown next to the “Music” or “Original” word as a checkmark. 

To make this visible, you need to revisit the show the “Current” state on 

the Designer window by activating the green state button on the BDS 

menu bar ( ). 

Click on the checkmark next to “Music”. In the properties window of the 

button you set the values for “Highlight if”, “Group” and “value”.  
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The checkmark should “Highlight if” the “Audio” stream is selected in 

group “Movie” with value “1” (which corresponds with audio track 1). 

The checkmark for “Original” must be set to highlight if “Audio” stream 

is selected in group “Movie” with value “2” (which corresponds with 

audio track 2). 

When the menu button “Music” or “Original” has been given a value to 

set the audio to a particular track, the “Highlight if” is already filled in. 

When you compose the menus and leave adding the real movies until 

later, you may have to fill in these values manually. 

The “group” item is something not used in this tutorial but each movie 

added to the movie list can join to belong to the same group. Any 

change in audio or subtitles set for that group applies to all movies that 

are part of this group. By default BDS puts each movie in its own group. 

If “Current”, “Selected” and “Normal” states need to be given their own 

position, you can move each state manually in the Designer view provided you 

have unlocked their fixed relative position using the menu button “Move whole 

button” ( ) on the project menu bar.  

 

Actions for “Popup” buttons 
The same procedure used for the “Menu” menu is also used for the 

“Popup” menu that also has the “Audio” button that starts the “Popup 

options” menu. 

The “Menu” button on the “Popup” menu must be assigned to jump to 

the “Menu” menu so a playing movie can be stopped and control is 

returned to the main menu. 

Actions for “Popup options” buttons 
The “Popup options” menu has the same two buttons “Music“ and 

“Original” as the “Menu options” and must be assigned the same 

actions. It also has the two checkmarks as “current” states that must be 

highlighted when a menu choice is activated. 

Copy/Paste using the Action Matrix 
In cases like this, where identical actions must be defined for buttons on 

different menus, it is often handy to use the “Action Matrix” window. 

You select the action for a button in one menu (copy) and then select 
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another menu and paste the action into the right cell for a button on 

that menu. 

Adding chapters (playmarks) menus 

Creating chapters 
A movie can be split in several chapters to allow the user to quickly jump 

to a significant scene. These scenes can be handpicked or generated 

automatically (like after about every 3 minutes). BDS allows both ways 

of doing it. 

There is always a chapter at the very start of a movie (BDS does this 

automatically) but it is useful to have one at the very end (you must 

specify this yourself). The latter allows the viewer to jump to the very 

end of the movie and do whatever comes next. This may be back to a 

menu but may also start another movie. What happens is defined in the 

“End Action” property of each movie. 

To create a chapter or set of chapters, the movie must first be opened. If 

no chapters yet exist, BDS starts inspecting the file first. 

 Select a movie in the “Movies” list of the Project Tree 

 In the properties of the movie select “Scenes” and press on the 

“>” button at the far right end. 

 The movie is inspected first or the chapter window opens 

immediately with earlier specified chapters. 

 
 After inspection, the “Scenes” windows opens showing the 

current chapter list (chapters are also referred to as “playmarks” 

by BDS) 
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It may show only the opening chapter 1. By using the slider 

underneath the movie frame, additional scenes can be selected 

and added using the “Add playmark” icon ( ) or press “Ins” 

key. 

Chapters can be generated automatically using the “Generate 

playmarks” icon ( ) or press Ctrl/M.  Chapters are always 

added to any already existing chapters, so you may want to 

delete old ones first. 

Note: whether hand-set or generated, modify the chapter setting to ensure it is set on a 

key frame boundary.  Key frames are complete pictures whereas all other frames only 

contain changes of the picture compared with the key frame. Only key frames allow to 

start a scene playing correctly with a full image. You find the next key frame by clicking 

on the “next key frame” button  or press Alt/Right-arrow. 

Without any further work, these chapters can be used on a remote 

control using the |< and >| buttons. There is currently no special menu 

to select a scene. Often this suffices if a viewer wants to jump forwards 

or backwards while running a movie. If a menu is needed to display the 

individual chapters, see section “Create chapter (scenes) menus” on 

page 34. 
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For the short example movie, manually chapters were set on key frames 

after every 30 seconds. The final chapter at the end is not normally 

shown in scene lists – therefore the chapter list displayed at the right of 

the movie frame has the final entry unchecked. 

You return to BDS main interface by closing the menu window by 

pressing on its “X” button at the top right hand corner. The “Scenes” 

counter of the movie properties is updated to reflect the current 

number of chapters defined. 

(If you automatically generate chapters you always get two more than 

you specify: the first and last chapter are not counted as generated, yet 

they are chapters). 

Create chapter (scenes) menus 
BDS allows you to generate a chapter menu where each chapter image 

becomes a visible small button you can select and then jump to that 

chapter in the movie. 

For this to work, all images of all chapters must first be saved in a special 

folder not used for anything else. Unlike the Quick Start video where this 

is done chapter-by-chapter, it can be done in one swift sweep once the 

chapters are defined as we did in the previous section. 

To generate images, open the “Scenes” window and press on the 

“Generate Scenes” button ( ) or press Ctrl/S. This opens the “generate 

scene menus” window. 
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The left hand part of the window is important. 

 check “Generate bitmaps” (creates screen dumps of chapter 

images in the movie) 

 check “Generate chapter images” (uses the screen dumps to 

create chapter buttons) 

 check “Generate menus” (uses the chapter buttons to fill the 

scenes menu that is automatically entered in the menu list of 

the Project Tree window) 

The right hand part shows how each chapter image is framed and 

numbered. The currently selected one is highlighted with a white 

border. If the chapters don’t fit, a follow-on menu is created and linked 

using the > and < buttons. 

With these three generating checks in place, the generation of images as 

well as menus for the chapters becomes fully automatic. 

 specify the output folder where the chapter images are stored. A 

suggestion is already made as empty subfolder within the 

project folder 

 Click on the “Generate bitmaps” button at the bottom. This 

creates bitmaps of the chapter points selected in a subfolder 

\bitmaps under the selected output folder 

Now it is time to generate the scene menus.  You need to specify in the 

left column how many rows and how many chapter images per row are 

to be shown. In this short movie 1 row with 5 chapters or less suffices. 

Also you need to specify where this scenes menu is accessed from. We 

will have to repeat the steps twice: once for Parent menu = “Menu” and 

once for Parent Menu = “Popup”.  In both cases these scene menus are 
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shown when the “Scenes” button is activated. You may wish to change 

the “Return key” value. By default it says that if the down arrow is 

pressed on the remote control, the “Scenes” menu disappears and the 

parent menu is displayed again. 

 

After the bitmaps have been generated, click on “Next” to specify the 

space on the menu where to show the chapter images. The indicated 

area is shown as layer on top of the menu through which it is accessed. 

You can make the area as big or small as you like – they will be shown 

either over the menu movie (when “Scenes” button is selected from 

“Menu” menu) or over the playing movie (when “Scenes” button is 

selected from “Popup” menu). This second “Generate scene menus” is 

precisely 1080 x 1920 pixels in size – the HD size of a bluray picture. But 

only the hatched block that will accommodate the chapter buttons will 

actually become the size of that menu. 

 
 

Modify the display size (hatched blue) by pulling on its handles displayed 

on all sides. The picture above shows how the scenes bar is shown on 
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the “Menu” menu above the “Menu” buttons area. By adjusting the size 

to fit the box of the “Menu” it looks a bit nicer. Special buttons like 

“Center horizontal” or “Center vertical” as well as notching the shape 

pixel by pixel using the arrow keys of the keyboard, allow you to position 

the scenes menu exactly. 

 

When satisfied click on “OK”. A scenes menu is now generated and 

inserted in the Project Tree list of menus. The buttons that jump to a 

specific chapter are also generated and entered in the Objects view of 

the Objects window. 

 

The Designer view shows how the menu will look eventually when the 

“Scenes” button is activated. You can change the appearance by 

modifying the “Generate menus” data. Here for example, we can make 

the chapter scenes slightly better spaced out by specifying to have 4 

chapters on a row instead of the initial five specified. 
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Re-generating the scenes menu creates a new menu (Scenes 2). The 

original one (Scenes 1) still remains. You can select and delete it if you 

wish (select and press <delete>). 

 

By clicking on any of the scenes in the Designer view, you highlight the 

button associated with that scene as well as its properties. Most are 

filled in the way they should, but you can make manual adjustments. 

In the picture below we selected the first scene on the Designer window 

and see that all other information windows synchronize. For example, 

select the “Chap 1” button. Project Tree shows the menu it is on, Objects 

shows the menu objects and highlights the “Chap 1” button,  Properties 

shows the properties of the “Chap 1” button (which consists of objects 

“btnChap n” (n= 1,2,3…)).  

Pressing the down arrow (as specified in “Return key”) returns to the 

“Menu” menu without scenes. Pressing right or left arrows move 

between the scene buttons, pressing “OK” starts the movie at the 

specified chapter. 

 



Blu Disc Studio Quick Start Guide 39 

 

Set scenes in Popup menu 
The same steps as used for the main menu, you have to perform for the 

“Scenes” button of the “Popup” menu. 

 

 

Simulate the project 
Once all movies are in place and all menus defined and buttons assigned 

and connected, the “Simulation”   (press F9) key allows BDS to 

compile the entire project after which you can test the menus. 



40 Blu Disc Studio Quick Start Guide 

For this to work, the Project Tree must have assigned a “First Play”. This 

is the “Menu” menu if we want to start with this menu when the disc is 

inserted in a player. 

  

The simulation starts with compiling the project and button assignments 

in java and shows its progress in a “Running” window.  

 

If menus cannot be found, movies are not defined, tracks not specified, 

error messages will tell you and you need to revisit the project. 

But if all is fine, the simulation menu opens and you can try the various 

options using the arrow keys and <return> key of your keyboard. The pc 

mouse won’t work. The simulation does not play any movie. When you 

select “Play” in the tutorial, you can use the <F5> key to simulate a 

“Popup” action from the remote control to display the popup menu. 

Use the simulation mode to check whether all menu buttons work as 

anticipated. Where they do not, go back to the project and modify the 

button properties accordingly (for right navigation or “OK” action) and 

restart the simulation. 
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Building the disc 
When all elements are properly connected and the actual movie streams 

are present, the final disc can be build. This is done by clicking on the 

“Mux by tsMuxer” button   or pressing Ctrl/F9. 

The Lite edition does not have a BDS muxer, so the freeware tsMuxer is 

used. You must install this and inform BDS where it is located. You 

specify this in File > Options in the tsMuxer box. 

 

While you are at it, you may want to check the Java JDK x64 box if you 

run on a 64 bits Windows platform. Not doing so may work fine, but if 

compilation complains about a “line 1” error – try again with the check 

mark set. 

 

The building of the disc starts again with the building information for the 

menus, but then it continues to mux all video, audio and subtitle 

streams of the movies that are defined within the project.  

The output is written to the location specified in the Project > Project 

Properties window. This window opens automatically when you want to 

mux the project to give you an opportunity to change the disc folder 

location. This way you may build different versions of the same project. 

 

By default the \Output folder is used within the project main folder. If 

the folder does not exist, BDS will create it. 

The progress of the build is given in a new window that changes its name 

constantly from “compiling” via “muxing” to “Finished!” 
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A sample output of the tutorial project is shown below. The \output 

folder then has all files needed to create a bluray disc, split over the two 

root \BDMV and \CERTIFICATE folders.  

Using a software player like Nero Bluray player or the freeware Leawo 

Blu-ray Player can be used to check whether the created disc indeed 

works as intended before committing the folders to a physical disc. 
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Burning the disc 
The created files in both bluray folders can be burned to bluray disc 

using a commercial package like Nero Burning ROM or a freeware 

package like ImgBurn and of course a physical bluray burner. 

In both cases it is useful to use the Bluray UDF mode (not the Nero 

Bluray BDMV mode) and to specify the use of UDF 2.50. 

Nero Burning ROM 
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The picture above shows the Nero Blu-Ray (UDF) setting where the 

version to use is specified under its UDF tab. 

Once specified, open the Disc content window (after pressing “New” on 

the previous menu) and drag the two created folders to the disc area. 

Click on the “Burn Now” button to start the burning process. 

Note: it appears that using the UDF 2.50 mode produces a faster responding 

bluray disc than when the BDMV template of Nero is used. 

 

ImgBurn 
For ImgBurn use the “Write files/folders to disc” option from the EZ-

Mode picker (available from the Mode menu) and specify UDF 2.50 

under its “Options” tab.  
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Fill the “source” area with the created bluray files by selecting the 

“browse for folder” icon and load both BDMV and CERTIFICATE folders. 

To start the burning process, click on the “burn now” button below the 

source area. 

 

 


